


From the Editor of 
Instructor/Electronic Learning in Your Classroom

Dear Technology Leader:

What you’re holding in your hands is a tool for bringing together three of your
school’s most pressing instructional priorities -- math, science, and technology -- in
a way teachers are sure to love: well-crafted, classroom tested lesson plans.

The eight lesson plans in this workbook use today’s most popular desktop applica-
tions, such as Microsoft Office 97 (with Microsoft Word 97, Microsoft Excel 97,
Microsoft PowerPoint 97 and Microsoft Access 97), Microsoft Internet Explorer 4.0,
Microsoft Publisher 97, and Microsoft Encarta 98 Deluxe Encyclopedia. These lessons
include step-by-step instructions for using this software, which will add to the guid-
ance teachers and students already get from the intuitive new Office Assistant and
other Help functions Microsoft is known for.

Developed by the editors of Instructor and Electronic Learning in Your Classroom in
partnership with Microsoft, this workbook is meant to be used as a resource for
staff development and as a working idea bank for classroom teachers. 

We hope that you and the teachers you work with find lots to be excited about
within the covers of this book, and that it sparks a wave of technology-based lesson
planning in your classrooms. 

Sincerely,

Mickey Revenaugh
Editor, Instructor/Electronic Learning in Your Classroom
P. S. More teacher activity guides for Microsoft products are available online at: 

www.microsoft.com/education/k12/resource/lessons.htm 
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Lessons at-a-Glance
classroomp r o d u c t i v i t y in the

LESSON GRADE LEVELS TIME ALLOTTED

THREE SQUIRRELS 
AND A PILE OF NUTS

ENDANGERED
SPECIES

SPACE CASE

CODE CRACKERS
MATH GAME

TRAITS R US!

SOLVING
POLYNOMIAL
EQUATIONS

CAMPAIGN 
HOT BUTTONS

High School

Middle School

High School

Middle School

Intermediate/Middle School

Middle School

Three to six class periods

Two class periods

Three to five class periods

One class period

Three to four class periods

One or two class periods

One week

High School

Intermediate/Middle School
IT’S IN THE 
(CHOCOLATE) CHIPS Two class periods
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Microsoft Excel 97
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INTERMEDIATE/
MIDDLE SCHOOL

IT’S IN THE
(CHOCOLATE) CHIPS

Students will investigate
which brand of chocolate
chip cookies contains the
most chocolate; they ana-
lyze and compare data using
M i c rosoft Wo rd and M i c ro s o f t
E x c e l, and then use M i c ro s o f t
PowerPoint to communicate
their findings.

◆ To provide students with
hands-on practice in the sci-
entific process: establishing
hypotheses, investigating,
recording data, comparing,
and writing conclusions

◆ To help students make the
connection between the study
of math and science and their
real-life concerns (such as
making consumer choices)

◆ To build students' commu-
nications skills

◆ Understanding of the con-
cept of mass and the use of
metric weights

◆ Basic familiarity with
Microsoft Office tools, includ-
ing Word, Excel and
PowerPoint

◆ Chocolate chip cookies
from two different brands,
five cookies per team

◆ Paper towels

◆ Food scale or other scale to
weigh in grams 

Two class periods

Ask students which brand of
chocolate chip cookies they
consider best and why.
Consider different criteria for
determining the best cookie:

Is it taste? Size? Amount of
chocolate? Explain that today
the class will investigate two
brands (A and B) of chocolate
chip cookies to determine
which contains the most
chocolate. Half the class will
experiment with Brand A and
the other half with Brand B. 

Before you organize the class
into teams, tell students they
will be conducting their exper-
iment using the Office tools.
They will use Word to write
their hypothesis and results;
Excel to analyze their data;
and PowerPoint to present
their findings in a slide show
and on the Web.

REQUIRED SOFTWARE
◆ MICROSOFT® EXCEL 97
◆ MICROSOFT® WORD 97
◆ M I C R O S O F T® P O W E R P O I N T® 9 7

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
HANDS-ON MATERIALS NEEDED



What's your favorite brand of
chocolate chip cookies? Is it
the one with the most choco-
late per bite? In this activity,
you will uncover the choco-
late quotient in several popu-
lar cookie brands. 

Preparing Your
Spreadsheet
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: You'll be using
a spreadsheet to track and
analyze your chocolate chip
data. Here's how to set it up:

1. Open Excel and create a
new worksheet, and save it
under a unique file name.

2. In cell A1, type the name of
the brand you're investigating.

3. In cells A2 through E2, type
these column headings,
respectively: Total Mass, Mass
of Chocolate, Mass of Cookie,
Number of Chips, and Mass of
Towel.

4. Highlight A2:E2. On the
Format menu, click Cells,
choose Alignment, then check
Wrap Text. Save again.

Making Your
Hypothesis
S O F T WA R E : M i c rosoft Wo rd

W H AT TO DO: S c i e n t i s t s
begin their investigations

with an educated guess
called a "hypothesis," which
they then test against re a l
data. Here's how to cre a t e
your own hypothesis:

1. Open Wo rd , c reate a new
document, and save it as
H y p o t h e s i s .

2. Choose an average cookie
f rom your set and estimate
how much of it is chocolate.

3. R e c o rd your estimate as a
hypothesis: "Our team
hypothesizes that Brand X
cookies contain an average
XX pro p o rtion of chocolate
per cookie." Express your
estimate as a fraction, a per-
centage, or a ratio.

4. Add notes about how you
reached your estimate. To
include a sketch, pull down
the View menu, click
Toolbars, choose Drawing,
and use the oval AutoShape.
Save your file.

Collecting Data
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Now roll up
your sleeves and get ready for
lab work. Here's what to do:

1. Choose one cookie, weigh it
to find its mass, and enter this
f i g u re into spreadsheet cell A3.

2. Weigh a sheet of paper
towel, and enter this mass in
E3. Since this figure will be
the same for every cookie,
select E3, click on the “fill
handle” in the corner of the
cell, and pull down to cover
as many cells as you have
cookies. When you release,
the figure will fill each cell.

3. On a towel, pick out the
chocolate chips from the
cookie.

4. Place the chips on another
towel and weigh them. In cell

STEP A

DESCRIPTION

STEP B

IT’S IN THE (CHOCOLATE) CHIPS
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Student Activity

STEP C



B3, create a formula, =X-E3.
Replace X with the weight of
the chocolate you just found,
press Enter, and the true Mass
of Chocolate will appear.

5. Now let Excel calculate the
Mass of Cookie based on the
other figures you’ve entered.
Go to cell C3 and type =A3-B3.
Press Enter. Copy the formula
by clicking on the fill handle
on the corner of the cell and
dragging down through C7.
When data is entered for each
cookie, Mass of Cookie will
automatically be calculated.

6. Count the chips and enter
this number in cell D3.

7. Repeat steps 1-6 for all five
cookies. Save all your piles of
chips and crumbs, labeling
the towels to keep each 
cookie's data separate.

8. Weigh each pile of crumbs
and see if this mass matches
what you've calculated in col-
umn C. How do you explain 
any differences you see?

Crunching Your
Data
S O F T WA R E : M i c rosoft Exc e l ,
M i c rosoft Wo rd 

W H AT TO DO: Here's how to
make sense of your data.

1. Calculate the average of
each of your cookie columns.
To do this, click cell A8 and
type in this formula:
=Average(A3:A7). Press Enter.
Click on the fill handle and
drag through cell E8.

2. Make a pie chart that
shows Mass of Chocolate and
Mass of Cookie as percentages
of the Total Mass. To do this,
◆ Highlight cells B8:C8.
◆ Hold down the CTRL key,
and highlight B2:C2. 
◆ On the Insert menu, click
Chart, choose Pie Chart, and
select a type. 
◆ Click Next two times to go
to Step 3 of the Chart Wizard.
◆ Click the Titles tab, and type
Chocolate Quotient.

◆ Click Data Labels tab and
choose Show Percent. Click
Finish.

3. Select the whole chart and
Copy it. Then open your
Hypothesis Wo rd document and
Paste the chart there. Compare
results to your estimate.

Comparing and
Communicating
S O F T WA R E : M i c ro s o f t
Powe r Point 

W H AT TO DO: You're about to
decide once and for all which
cookie brand has the highest
chocolate quotient – and then
tell the world! Here's how:

1. Compare your results with
those of the other teams ana-
lyzing the same brand. If
results differ significantly,
reweigh and recalculate. 

2. Put together a PowerPoint
presentation summarizing
your results. Import spread-
sheet data and graphs, or cre-
ate new ones as needed. For
extra dazzle, try the
PowerPoint Animation option.

3. Make your presentation to
the other half of the class;
they’ll do the same. Which
cookie brand rules?

4. Combine your results into a
whole-class PowerPoint pre-
sentation that you can deliver
to other classes or the entire
school.

5. Save your team and class
PowerPoint presentations as
HTML documents to post on
your school or classroom Web
page. 

IT’S IN THE (CHOCOLATE) CHIPS
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INTERMEDIATE/
MIDDLE SCHOOL

E N D A N G E R E D
S P E C I E S

In this cro s s - c u rricular activity,
students will re s e a rch the
issue of species endangerm e n t
by exploring threatened 
animals, their habitats, and
the environmental challenges
associated with them.

◆ To explore the relationships
between living things and
their environment

◆ To guide students toward
understanding of the causes
of species endangerment

◆ To build students' research
and communications skills

◆ Basic research skills

◆ Basic computer skills

Approximately one week

Start by asking your students
what they know already about
endangered species. Ask for a
volunteer to record the class's
thoughts on the board. Most
likely, students will list a num-
ber of specific species; ask

your volunteer to circle these
with guidance from the class.
Then ask: What are some of
the reasons these species are
threatened? Answers should
include: human encroach-
ments on natural habitats;
pollution damage to habitats;
oversupply of natural preda-
tors; poaching and hunting.

Next, using a PC viewer dis-
play system or large monitor,
open Microsoft Encarta 98
Encyclopedia Deluxe. Click on
MEDIA FEATURES and choose
BIODIVERSITY under COLLAGES.
Discuss the meaning of biodi-
versity with your class. Then
click on some of the "jumps"

and explore different aspects
of life on Earth.

Finally, guide students to
Microsoft Encarta Virtual Globe
for an overview of habitats.
From the home page, click the
LEARN ABOUT THE EARTH head-
ing. Scroll though to WORLD

THEMES, then to ENVIRONMENTAL

CHALLENGES. Choose HABITAT AND

WILDLIFE DESTRUCTION to show
the wealth of articles, videos,
and related material there.

Now divide the class into
g roups of three or four, and tell
students they will be develop-
ing a re s e a rch project about
one endangered species.

REQUIRED SOFTWARE
◆ MICROSOFT® ENCARTA 98

ENCYCLOPEDIADELUXE
◆ MICROSOFT® ENCARTA

VIRTUAL GLOBE
◆ MICROSOFT® INTERNET EXPLORER
◆ MICROSOFT® WORD 97
◆ MICROSOFT® POWERPOINT® 97

OPTIONAL SOFTWARE
◆ MICROSOFT® GREETINGS WORKSHOP

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

The Biodiversity collage in Encarta 98 offers a vivid overview.

Teacher Guide
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In this activity, you will work
in a group to research one
endangered animal species.
You’ll find out and explain
why it is endangered and rec-
ommend measures humans
can take to protect the
species from extinction.

Selecting Your
Species
S O F T WA R E : M i c ro s o f t
E n c a rta 98 Encycl o p e d i a
D e l u xe, M i c rosoft Wo rd

W H AT TO DO: With your
group, pick two or three
endangered animals you're
particularly interested in (use
the list on the board if you
need ideas). You'll be finding
out a little more about each
one before you make your
final choice for your research
project. Here's how:

1. Open a new Word docu-
ment, go to the Table menu,
and choose Insert Table to
create a quick table for listing
your endangered species pos-
sibilities. Record what your
group knows about each
species and what factors
threaten its existence. Save
your document.

2. Next, open E n c a rta 98, go to
Encyclopedia Articles, choose
Find, and type “endangere d
species” into the Pinpointer

tool. Explore several art i c l e s
about diff e rent animals; use
the Pinpointer to track down
additional choices.

3 . Talk about various species,
and choose one to re s e a rc h .

Doing Yo u r
R e s e a rc h
S O F T WA R E : M i c ro s o f t
E n c a rta 98 Deluxe (or
E n c a rta 98 plus Micro s o f t
Wo rd ) , M i c rosoft Encart a
Vi rtual Globe, M i c ro s o f t
I n t e rnet Explore r

W H AT TO DO: Start digging
into your research and record-
ing your findings. 

1. In Encarta 98 Deluxe, go  to
Encyclopedia Articles. Choose
Research Organizer from the
toolbar. Open a New Project,
Save it, and create a card for
each piece of information
(text, pictures, your own
notes) you find. Research
Organizer will ask you to

Start your research with the Endangered Species article in Encarta 98.

STEP A

DESCRIPTION

STEP B

ENDANGERED SPECIES

Student Activity
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name each card and cite its
source. It will add the card to
an outline you can organize
any way you want. (If you
don’t have the Deluxe version
of Encarta 98, you can copy
and paste notes into your
Word document.)

2. Focus your research on
questions like these: How do
the needs of this species con-
flict with those of humans?
What other factors are endan-
gering this species? Here are
some other angles to explore
for research:

◆ Use the InterActivities
Population section of E n c a rt a
9 8 to study how the human and
animal/plant populations have
changed. Create a graph in
E x c e l to show population pat-
t e rns in your species' location.

◆ Using Virtual Globe, locate
your species' habitat. Import
maps for your report.

◆ In Encarta 98, use the More
Information button to connect
to related Internet resources

such as the Conservation
I n t e rnational Web site above
( h t t p : / / w w w. c o n s e rv a t i o n . o rg). 

Presenting Your
Findings
S O F T WA R E : M i c ro s o f t
E n c a rta 98 Deluxe, M i c ro s o f t
Wo rd , M i c rosoft Powe r Po i n t ,
M i c rosoft Gre e t i n g s
Wo rkshop (optional)

W H AT TO DO: Go back to
Research Organizer and make

sure you have all the data you
need. Reorganize your outline
if necessary. Then go to File
and Export as an RTF file. Do
one of the following:

◆ Open your Word document
from Step A, import your
Research Organizer material,
and use it to write a report in
your own words. Include
graphics, maps, and charts.
End with recommendations
for preserving the species.

◆ Open a new PowerPoint pre-
sentation, select Outline View,
and import your Research
Organizer RTF file. Edit the
material to create a slide pre-
sentation. Be very selective
about what you’ll show on
screen, and copy the rest into
Notes View as your script.

◆ Save either your Word or
PowerPoint file as HTML to
create a class Web site on
endangered species.

◆ Open Greetings Workshop
and choose Cards; create a
design and text that tell the
world about your species and
how it can be saved.

ENDANGERED SPECIES

STEP C
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MIDDLE SCHOOL

THREE SQUIRRELS 
AND A PILE OF NUTS

Students learn to solve
s t o ry problems using a
s p readsheet in combination
with various pro b l e m -
solving strategies.

◆ To provide students with an
engaging opportunity to exer-
cise problem-solving skills

◆ To demonstrate M i c ro s o f t
E x c e l as a problem-solving tool

◆ To provide a model for solv-
ing and constructing story
problems

◆ Familiarity with various
p roblem solving strategies,
including trial and erro r

◆ Basic understanding of how
to use Excel

◆ Six dozen nuts in the shell
(optional)

One or two class periods

Review problem-solving
strategies, then pose a simple

story problem. For example:
Sami has twice as many CDs
as Maria. Jamal's CD collec-
tion is one-and-a-half times
the size of Sami's and three
times as big as Maria's. If
Maria could load her 6-CD
changer three times without
repeating, how many CDs
does Jamal have?

Ask the class: What are the
unknowns? What information
does the problem give us?

s=2m j=1.5s     m=6 x 3

With your class, set up alge-
braic equations based on the
problem's unknowns and
givens; for example: j=1.5 X
(2m).  Have half the class
solve the problem algebraical-
ly, while the other half uses
trial and error, plugging in and

testing out numbers for differ-
ent variables. (Answer: Jamal
has 54 CDs.)

Now tell students they are
about to tackle a much tricki-
er story problem, but that
they can use the computer
and Excel software to help
them find solutions. Note that
you also have manipulatives
(in this case, nuts) for hands-
on problem solving.

Divide your class into teams
of three, and give each team a
copy of the Student Activity
pages. Assign one third of
your teams to start with
Strategy X (trial-and-error; see
answer key below), one third
with Strategy Y (algebra), and
the last third with Strategy Z
(hands-on).

REQUIRED SOFTWARE
◆ MICROSOFT® EXCEL 97
◆ MICROSOFT® WORD 97

or MICROSOFT® PUBLISHER 97

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide

HANDS-ON MATERIALS NEEDED

Here are the formulas students should figure out. One answer for B2 is 25.



THREE SQUIRRELS AND A PILE OF NUTS
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Student Activity

How many ways can three
sneaky squirrels divvy up one
pile of nuts? The story prob-
lem below will give you a
chance to find out. It will also
give you practice using differ-
ent strategies for solving
problems, and show you how
you can use the computer and
Excel to help solve them. In
the end, you’ll have a chance
to make up and trade fun
story problems of your own.

Analyzing the
Problem
S O F T WA R E : N o n e

W H AT TO DO: Your first step
in solving any story problem
is to analyze it – in other
words, take it apart, and make
sure you understand all of its
pieces. Look carefully at the
"Three Squirrels and a Pile of
Nuts" problem below, and
have one member of your
team read it out loud. Then:

1. Take turns stating the pro b-
lem in your own words. If you
and your teammates have dif-
f e rent ideas about what the
p roblem is asking for, talk it
over until you can agre e .

2. On a piece of scrap paper,
jot down the unknowns in this
p roblem. What don't you
know? What is the pro b l e m
asking for?

3. Next, write down any bits of
specific information the pro b-
lem may give you. What do
you know?

DESCRIPTION STEP A



Now you're ready to move on
to a problem-solving strategy.
All the teams in your class
will be trying Strategies X, Y,
and Z, but not necessarily in
that order. Ask your teacher
which strategy you should
start with.

Trial and Error
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: In this step,
you'll be setting up a spread-
sheet that will let you try out
various combinations of num-
bers to solve the problem. 

1. Following the sample
b e l o w, label your rows for
S q u i rrel 1, Squirrel 2, and
S q u i rrel 3. Label your
columns "No. of nuts in pile,"
"No. of nuts after s/he eats
1," and "No. of nuts s/he
leaves behind." 

2 . Highlight cells B1:D1, go to
the Format menu, choose
Cells, click on the Alignment
tab, and check Wrap Te x t .
Then adjust the cell width so
the text fits on two lines.

3. N o w, figure out form u l a s
for all the cells that will let
you plug in and test out num-
bers. Remember to make
each cell relative to the oth-
ers, so that a number you
plug into one cell's form u l a
will affect the rest. Here are a
few hints:

◆ The formula in cell C2
should be =B2-1, because the
s q u i rrel eats one nut fro m
the pile in B2.

◆ The formula for D2 is
=(C2/3)*2, because Squirrel 1
leaves two-thirds of the pile
b e h i n d .

◆ The formula for B3 is =D2,
because Squirrel 2 finds the
pile the way Squirrel 1 leaves
i t .

4. Once all your formulas are
in place, test out your
s p readsheet by plugging a

number into B2. You may end
up with a lot of weird - l o o k i n g
fractions – and you know
these squirrels aren't going
to settle for anything less
than whole nuts! Keep try i n g
numbers until you find one
that gives you whole num-
bers throughout. What pat-
t e rns do you see?

5. Print your spre a d s h e e t
twice, once showing the for-
mulas and once with your
whole-number solution in
place. (Ask Office Assistant
for help if you need it.) Then
move on to another strategy.

Algebra Power
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: With this prob-
lem-solving strategy, you'll be
setting up an algebra equation
to solve.

1. Open the Excel worksheet
used for Strategy X, go to the
Edit menu, and choose Move
or Copy sheet, and click
Create A Copy. In your new
worksheet, highlight B2:D4
and press Delete, leaving the
column and row headings.
Now you have plenty of room
to create a table for defining
your variables (see sample,
next page).

2. The variables you most
need to solve for are: 

x= nuts in original pile
y= number of nuts each

squirrel gets in the end.
Record these at the bottom of
your worksheet.

3. Here are some hints: Put in

TIP: Remember, to enter a

formula in a spreadsheet

cell, always type in an

equal sign (=) first.

THREE SQUIRRELS AND A PILE OF NUTS
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STRATEGY Y



x as Squirrel 1's "No. of nuts in
pile." When it comes to solv-
ing for y, remember that it is
one-third of however many
nuts are left in the end, so
y=1/3 (last entry in table).

4. After you fill in your table,
put together an equation. You
can type this in your work-
sheet below your table. Show
steps for simplifying the equa-
tion. Then test it out with sev-
eral numbers.

5. Make sure your worksheet
shows all the steps you fol-
lowed to write and solve the
equation. Then move on to
another strategy.

Hands-On
Thinking
S O F T WA R E : M i c rosoft Wo rd

P LU S : 3 dozen nu t s

W H AT TO DO: With this strat-
egy, you'll be solving the prob-
lem the way a squirrel would
– one nut at a time!

1. Count out the number of
nuts your group would like to
start with (not necessarily all

you have). Put these in your
starter pile. Open a Word doc-
ument and make a note of the
number.

2. Make one member of your
team Squirrel 1, and have him
or her tackle the pile of nuts
the way the first squirrel in
the story did. Warning: No
fractions of nuts allowed! Let
Squirrel 1 take several tries
until she or he ends up with
whole amounts after each
step. Record these numbers.

3. Now the teammate who's
playing Squirrel 2 should work
through the steps. Again, no
fractions – so both Squirrel 1
and 2 may need to go back
and adjust their piles. Record
the numbers that work.

4. Finally, Squirrel 3 should
take his or her turn. Adjust as
needed, and record the results
in your Word document.

5. When Squirrel 3 is through,
divide the nuts that are left. If
the pile doesn't divide by
three, adjust all the way back
through the  problem. Record
your tries and your final
answers.

6. From all your notes, write

several sentences (with pic-
tures if you'd like) describing
the steps and numbers that
finally gave you the right
answer. Then move to another
strategy (by the end of this
activity, you will have tried all
three!).

C reate a Pro b l e m !
S O F T WA R E : M i c ro s o f t
P u blisher or Microsoft Wo rd

W H AT TO DO: Here's your
chance to make up a story
problem as tricky as "Three
Squirrels and a Pile of Nuts." 

1. With your team, think of a
problem that has at least
three steps and requires at
least two of the four basic
math operations (addition,
subtraction, multiplication,
division).

2. Create a story to go with
the problem. For extra zip,
use your classmates' names
and some familiar settings,
like your classroom or school
cafeteria.

3. Solve the problem on a sep-
arate sheet of paper, and
check your work.

4. Launch Microsoft Publisher,
choose the Flyer PageWizard,
and type in your problem. (As
an alternative, you can use
Word.) Add graphics and a few
hints to help people solve the
problem. Print and proofread.

5. Make a separate flyer with
the solution. Print it and proof
it, then hide it away!

6. Exchange problems with
another team. Stump or be
stumped!
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MIDDLE SCHOOL

SPACE CASE

This activity asks students to
to design, write, edit, and pub-
lish a brochure to "sell" a
space research project.

◆ To build understanding of
the social impact of scientific
advances

◆ To inspire students to
"design" and "sell" a space
mission that will advance the
overall cause of space explo-
ration

◆ To develop students' skills
in written, visual, and oral
presentations

◆ Basic research skills

◆ Basic knowledge of
Microsoft Publisher and
Microsoft PowerPoint

Three to four class periods

Use Microsoft Encarta 98
Encyclopedia along with a PC
attached to an overhead pro-
jection device to take a jour-
ney through the history of
space exploration, from the
Sputnik days of the 1960s
through the Apollo moon mis-

sion to the Challenger disaster
to the recent remote-robot
exploration of Mars. 

Talk about how public senti-
ment has changed over the
decades of space exploration.
Why might people's intere s t
wax and wane? Does the public
have a clear sense of the "why"
of space travel today? How
i m p o rtant do your students
think the space program is?

As a class, brainstorm a list of
three to six objectives for
space exploration in the 21st
century. What new frontiers
should we be aiming for?
What social problems could
be solved through successful
space missions? What side

benefits might we see in terms
of technology advances and
product development?
Encourage students to think
imaginatively but also to
remember the monumental
challenges of space travel in
terms of cost, time, distance,
and technical capacity.

Next, have students pair up
into space mission planning
teams. Assign each team to
conceptualize a mission that
would accomplish both scien-
tific and social goals – one
that the public could enthusi-
astically support, with the
right encouragement. Then
have students follow the steps
on the next two pages to "sell"
their space mission.

REQUIRED SOFTWARE
◆ MICROSOFT® ENCARTA 98

ENCYCLOPEDIA
◆ MICROSOFT® PUBLISHER 97
◆ MICROSOFT® POWERPOINT® 97

OPTIONAL SOFTWARE
◆ MICROSOFT® WORD 97

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

From  the “Exploring the Heavens” collage in Encarta 98, you can
launch into multimedia articles on key topics in space exploration.
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People jump on the science
bandwagon when they under-
stand its relevance to their
lives. Successful scientists
offer ideas that count, and
they communicate their ideas
to the public. In this activity,
you and your partner will
imagine an important space
mission and communicate
with the public about it in a
persuasive, informational
brochure and presentation.

Planning Your
Brochure
S O F T WA R E : M i c rosoft Wo rd

W H AT TO DO: With your part-
ner, make some decisions
about your imaginary space
mission. What are the goals of
your mission? What are its

most exciting features? What
are its vital statistics: time
frame, mechanical require-
ments, personnel, costs? How
will the project benefit sci-
ence and the public?

Open a Word document,
answer these questions and
outline what you'll want to
say about the mission in your
brochure. Decide what main
points the text should cover,
and what graphics and other
visuals you'll need. Then split
up the work of creating and
assembling these materials.

Creating a Draft
S O F T WA R E : M i c ro s o f t
P u blisher or Microsoft Wo rd

W H AT TO DO: Use the
B ro c h u re PageWi z a rd in
P u b l i s h e r to create your basic
b ro c h u re layout, or Wo rd. 

1. Choose the format you
think will best get your mes-
sage across, then fill in infor-
mation as PageWi z a rd asks
you for it. Substitute your
team name and school
a d d ress for the business
name and addre s s .

2. In the spaces provided, cre-
ate persuasive headlines and
text that sells. Replace graph-
ics with selections from the
Science and Technology cate-
gory of the Clip Art Gallery, or
import some from Encarta 98.

3. Inside your bro c h u re, cre-
ate messages that explain
your mission, promote its
benefits, and lay out its vital
statistics. You and your part-
ner should swap off writing
and editing.

4. Decide what action you
want the public to take to
show support for your mis-
sion. Should citizens write to
their Congressional re p re s e n-

Create a Microsoft Publisher brochure that makes your space case.STEP A

DESCRIPTION

STEP B

SPACE  CASE
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WEB SITES TO CHECK OUT

The Space Center
http://www.imasof.com/tsc/tscmain.html
A fascinating look at the past, present,
and future of space exploration, with
links to photos, videos, illustrated time -
line, and a very cool space shop.

Explore Space with SEE
http://www.sni.net/explore
Billions and billions of links to the who,
what, when, where, and how of space
exploration. If you’ve ever worn a 
pocket protector, you’ll love this site.

National Space Society
http://www.nss.com
Want to help shape a spacefaring
future? Beam up to this site and make
your voice heard. Or just listen. 



tatives? Should they plan a
trip to witness the launch?
Should they send fan e-mail
to mission control? Whatever
your call to action, use the
back cover of the bro c h u re
to clearly communicate it.

5. Print out a draft of your
b ro c h u re, pro o f read it, then
fine-tune it before printing a
final version. If your teacher
a p p roves, you may want to
make copies to hand out to
your classmates. 

TIP: By saving your bro c h u re
as an HTML document, you
can post it on your school’s
intranet or Internet Web site.

Presenting Your
Mission
S O F T WA R E : M i c ro s o f t
Powe r Po i n t

W H AT TO DO: Now it's time to
bring your brochure to life as
a persuasive, attention-getting
PowerPoint slide show.

1. Reread your brochure and
pick out three or four of your
most important points. These
will form the basis of your
slide show.

2. Open PowerPoint, select the
Outline view, and type in your
key points as slide headings,
beginning with the name of
your mission and team name. 

3. Go to your title slide and
highlight your team name.

Under the Insert menu,
choose Hyperlink, and link to
your brochure file.

4. On one of your slides, add
a picture from Encarta 98 by
going to the encyclopedia arti-
cle, selecting the picture,
pulling down the Options
menu, and selecting Copy
Image. Paste it into your
PowerPoint slide.

5. Continue adding text, and
t ry Wo rd A rt to create eye-
catching titles. Insert graphics
f rom the O ffice 97 Clip Gallery,
c h a rts, and more. Just re m e m-
ber not to put too much infor-
mation on each slide.

6. When your slides are com-
plete, go to Slide Sorter view
and add Transitions, such as a
slow dissolve or a quick wipe.
Save your work.

7. Now show your finished
PowerPoint slide show to the
public (your classmates) and
get ready for the countdown
to launch!

SPACE CASE
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MIDDLE SCHOOL

CODE CRACKERS
MATH GAME

This engaging and challeng-
ing math game provides stu-
dents with opportunities to
work with math operations
and simple algebraic equa-
tions by creating a spre a d-
sheet-based "rule machine."

◆ To build students' skills in
math operations and algebraic
thinking

◆ To put spreadsheets in stu-
dents' hands as problem-solv-
ing tools

◆ To promote cooperative
math learning

◆ Understanding of M i c ro s o f t
E x c e l s p readsheet use

◆ Fluency in math operations
and basic algebraic thinking

One class period

Introduce the game by demon-
strating how math operation
"rules" work.  On an overhead
or the chalkboard/whiteboard,
write the following headings:

In, Out, Rule. Tell students
that what you've created is an
old-fashioned Code Cracker
math machine. Write the num-
ber 2 under In; under Out,
write 14; leave Rule blank for
now.

Ask students for three or four
possible formulas you might
have used to get from 2 to 14;
when they all call out 2 x 7,
tell them that your formula, or
rule, uses two math opera-
tions, not just one. Write their
guesses under Rule.

Next, write several other Ins
and Outs based on the same
rule, such as 4, 24 and 7, 39.
Ask students to keep guessing
until they figure out that your
rule is 5 x (In) + 4.

Give students a few minutes
to write and test their own
rules, then ask for volunteers

to try stumping the class
using your old-fashioned Code
Cracker.

Then, using a large monitor or
LCD projector, demonstrate
how to set up a modern Code
Cracker using Excel. (Follow
the model above, and check
the Student Activity directions
on the next page for set-up
details.) Run through a few
practice rules, showing stu-
dents how to create and copy
the formula in column B and
what happens when you type
different variables in column
A. Ask students: How is Code
Cracking different with this
machine? 

Have each student choose a
partner, hand each team a
copy of the Student Activity
page, and let the code crack-
ing begin!

REQUIRED SOFTWARE
◆ MICROSOFT® EXCEL97

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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With this math game, you and
your partner will take turns
posing math rules and trying
to guess them using a work-
sheet "machine" you create
with Excel. Whoever guesses
the most rules quickest, wins! 

Make Your
Machine
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: With your part-
ner, decide who should go
first. Partner 1 should then
follow these steps while
Partner 2 is not looking.

1. Launch Excel, open a new
worksheet, and save it.

2. Follow instructions in the
Tip box, below, to set up your
Code Cracker machine.

3. Type a number in cell A3.

4. In cell B3, type a rule (for-
mula) that uses the number in
cell A3. Remember to start
your formula with an equal
(=) sign. Use at least two but
not more than three math
operations in your rule. 

5. Select your rule, click on
the fill handle in the corner of
the cell, and drag to copy it in
B4:B7. 

6. Type a different number in
each of cells A4 through A7;
cells B4 through B7 will show
values that represent your
rule. Save your work.

7. Hide your rules by clicking
on the View menu and dese-
lecting Formula Bar.

Crack the Code!
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Now Partner 2
will try to guess the rule
Partner 1 has devised. Your
time limit: two minutes! 

1. Look carefully at the num-
bers in columns A and B.

What rule, using more than
one math operation, could
turn A into B? Click cell C3
and type in your main guess
plus some other guesses

2. Click on cell A4, and
replace that number with any
one you choose. What do you
see in B4? Review and revise
your guesses if necessary.

3. Try out more numbers in
column A until you feel
absolutely sure of the rule, or
until your time's up.

Tally and Switch
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Partner 1 can
now reveal the rule by click-
ing on cell B3. Did Partner 2
guess correctly? If so, she or
he gets 5 points – plus 1 addi-
tional point for every other
workable rule. Tally the points
in an empty place on your
worksheet, then switch places
so Partner 2 creates rules for
Partner 1 to guess. Whoever
reaches 50 points first, wins!

STEP A

DESCRIPTION

STEP B

CODE CRACKERS MATH GAME

Student Activity
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STEP CTIP
To set up your spreadsheet:

1. Type Code Crackers in cell
A1. 

2. Highlight cells A1:C1.

3. On the Format menu
choose Format Cells.

4. Click on Alignment, choose
Merge Cells, then click OK.

5. Click the Center button to
center the text across
columns A:C.

6. In cell A2, type IN. In cell B2,
type OUT. In cell C2, type
RULE.

7. Select cells A2:C2 and
Center your text.

Create and hide rules in column B for your partner to guess!



HIGH SCHOOL

TRAITS R US!

In this supplement to your
study of genetics, students
l e a rn more about here d i t y
by collecting and analyzing
i n f o rmation about their own
and their classmates’ char-
acteristics (such as hair
color and height) and traits
(such as ability to ro l l
tongue or raise one eye-
b row). As the activity pro-
g resses, students will be
amazed to discover the
genetic diversity within
their own classroom! 

◆ To deepen students' under-
standing of heredity through
analysis of characteristics and
traits in their peer group

◆ To provide practice creat-
ing and using a Microsoft
Access database, including
hands-on experience in col-
lecting, analyzing, and report-
ing data

◆ Fundamental understanding
of genetic principles 

◆ Familiarity with basic data-
base design and terminology,
with special focus on Microsoft
Access

Three to five class periods

Ask the class: How many of
you can roll your tongues?
Raise one eyebrow? Take a
quick tally. Ask: Why do some
people have these traits while
others do not? Guide students
toward understanding that
these traits are hereditary,
passed along the same way
that hair and eye color are.
Note that other hereditary
traits include left- and right-
handedness and the ability to
whistle.  

Tell students that they will be
creating a database of genetic
characteristics and traits in
their own classroom. Using a
large monitor or a PC Viewer,
open Access. Then:

1. From the File menu, choose
New Database, then a Blank
Database. Name and Save it.

2. In the next screen, click the
Table tab. Choose New, click
DesignView, then OK.

3. With your students’ help,
type field names in the Table
design (see sample below). 

4. For each field with a set
number of choices (such as
Left-/Right Handed), create a
pull-down menu for easy data
entry. Click on the Data Type
cell and then down arrow.
Select LookupWizard, click the
“type in values” option, then
click Next. Enter your choices
under Col 1. Click Next, and
name your lookup column
with the same name as the
related field. Click Finish.

5. Save and close your table.

6. Divide your class into
teams. Teams will work sepa-
rately on Step A and combine
forces for the remaining steps.

REQUIRED SOFTWARE
◆ MICROSOFT® ACCESS 97

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED
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A re you the only “lefty” among
your friends? How many kids
in your class could wiggle their
ears if you asked them to?
With this activity, you and
your classmates will create a
database of your own genetic
traits and characteristics.
You'll compare your classro o m
results with statistics fro m
“the real world,” and then look
for other patterns in your data.
Some students may also want
to look for characteristics and
traits among members of their
families. 

Create Your 
Data Form
S O F T WA R E : Microsoft
Access

W H AT TO DO: With your
teacher, you’ve already

defined the fields in your
database. Now you will work
in a team to develop the form
that you and your classmates
will fill out on the computer to
enter data into your database.
Other teams in your class are
working on form designs, too.
When all are complete, the
whole class will pick its
favorite form and data entry
can begin. 

1. Open the empty database
your class created with the
teacher, click on the View
menu, and choose Database
Objects.

2. In the submenu, select
F o rms. Click the New button
and choose the Form Wi z a rd
option. Choose the Table you
and your classmates just cre a t-
ed with your teacher, then
click OK. Then from the
Available Fields listed below,
choose the ones you most
want classmates to fill in
(which could be all of them)
and add them to the list of
Selected Fields in the ord e r
you want them to appear. 

3. Now work through the
remaining steps of Form
Wizard. At the last step, give
your form your team name,
and select the option that lets
you Modify the Form’s Design
if you’d like to fine tune it;

STEP A

DESCRIPTION

TRAITS R US!

Student Activity
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Compete with other teams to design the best database form.



then click Finish. Be sure to
Save when you are done tin-
kering! 

4. Each team should present
its finished form on the over-
head viewer. Vote on a
favorite, and go to the View
menu. Choose Design View if
you need to modify it. Then
Save as CLASS FORM.

Enter Your Data
S O F T WA R E : M i c ro s o f t
A c c e s s

W H AT TO DO: You and your
classmates will now go to the
computer one at a time and:

1. Launch the class database
and open the Class Form. At
the bottom of the form (in
Form View), click on New
Record and type in your data.
Everyone else in class will do
the same.

2 . For an extra touch, scan in a
photo of yourself. Hint: Ask the
O ffice Assistant how to add an
unbound picture. 

Analyze the Data
S O F T WA R E : M i c ro s o f t
A c c e s s

W H AT TO DO: When all of
your class's data has been
entered, your team should
decide on one main variable
to explore. For example, you
might want to focus just on
the boys in your class, and
then find out what character-

istics and traits they have.
Here’s how:

1. On the View menu, choose
Datasheet Views. Under the
M/F field, click in a record
that contains Male (or M). On
the Records menu, choose
Filter, then choose Filter by
selection. Those records will
appear on the screen.

2. Next, choose several sub-
variables, such as: How many
boys in your class are left-
handed? What is the range of
heights among the boys?
Choose the correct columns
one at a time, click on
Records, and Sort.

3. When you find a pattern
worth noting, create a printed
report on it. On the Window

Menu, choose the name of

your database. Click the
Reports tab, then click New.
Click the ReportWizard and
your query or table. Select the
variables you want to focus
on, such as Gender (M/F) or
Left-/Right-Handedness (see
sample, above). Then let
Report Wizard guide you
through creating a report
based on that Query. Share
with your classmates, and
conduct additional Queries.

4. Use the ChartWizard to pre-
sent some of your data visual-
ly. Post your findings on a bul-
letin board, and find answers
(from the library and your sci-
ence teacher) to questions the
data raises about genetics.

TRAITS R US!

STEP B
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Use the Query and Report functions in Access to explore various
combinations of genetic characteristics and traits in your class.

STEP C
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HIGH SCHOOL REQUIRED SOFTWARE
◆ MICROSOFT® EXCEL97

SOLVING POLYNOMIAL
E Q U A T I O N S

In this modeling activity, stu-
dents will learn how to use
spreadsheets as a sophisticat-
ed tool for analyzing, visualiz-
ing, and solving mathematical
problems.

◆ To aid students in graphi-
cally visualizing polynomial
equations, beginning with
cubic equations

◆ To model for students how
Excel spreadsheets can be
used as problem-solving tools

◆ To introduce students to
advanced Excel spreadsheet
functions

◆ Basic familiarity with
s p re a d s h e e t i n g

◆ Fundamental grasp of cubic
equations and other polyno-
mial equations

Two class periods

1. Start this lesson by talking
about spreadsheets and how
students may have used them.
Explain that they will be learn-

ing about several functions of
the Excel spreadsheet that will
help them solve polynomial
equations.

2. On a large monitor or an
LCD projector, open Excel and
choose a new worksheet. 

3. Show students how to
define a series of cells as vari-
ables in an equation. In the A
column, type x into A1, then
enter a sequence of numbers
from -3 to 3 starting in cell A2.
Select the entire column of
cells, press CTRL + SHIFT +F3,
and specify in the dialog box
that you want the name this
series x; create the name in
the top row. Next, go to cell
B1 and type y. In cell B2 cre-
ate an equation using x, such
as x^2 (x to the power of 2).
Copy this formula and paste it
in cells B3:B8. Point out to stu-
dents how the value of the B
cells change. Select B1:B8 and
name the series y.

4. Next, walk through Excel's
advanced graphing features.
Select cells A1 through B8,
and choose ChartWizard from
the Insert menu. Choose the
XY scatter chart function.
Explore the results.

5 . F i n a l l y, introduce students to

the Goal Seek function, which
allows the user to indicate a
d e s i red ending value and ask
the spreadsheet to re t u rn a
variable that meets it. Choose
cell B3, then go to Tools and
click on Goal Seek. In the dialog
box, specify B3 as the cell you
want to set; give it a diff e re n t
value, and specify A3 as the
cell that should change to meet
it. Close the dialog box and
note the re s u l t .

6 . Hand out the Student
Activity pages. Show students
that they will be using all thre e
of the functions you just intro-
duced to help solve their
cubic equations.

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide



Here's your chance to use
Excel to help you solve those
tricky cubic equations. 

Define Your
Coordinates
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Set up your
Excel spreadsheet to reflect a
cubic equation. The equation
we'll be modeling in this les-
son is 2x3 + 6x 2 - 18x + 6= 0 .

1 . Open a new worksheet. In
A1, type this text: Graph of y =
2 x3 + 6x2 - 18x + 6. To position
the exponents (such as 3) cor-
rectly in the text, highlight
each one, go to the Form a t
menu, choose Cells, click on
the Font tab, and click
Superscript. Decrease the font
size slightly. N o t e : In spre a d-
sheet formulas, as opposed to
text, designate exponents by
p receding them with the ^ sign.

2. In cell A2, type x. In cell B2,
type y.

3. In cells A3:A11, enter a
sequential series of values
from -5 through 3 (see above).

4. Select A2:A11, press CTRL +
SHIFT + F3, and name this col-
umn x (see above).

5. In cell B3, enter the formula
for y, which is =2*x^3+6*x^2-

18*x+6 . Copy this formula
and paste it in cells B4:B11.

6. Look at the values now
showing up in column B. Do
you see any patterns? Save
your work.

Graph the
Equation
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Now you'll
want to visualize the equa-
tion by making a graph.

1. Highlight A2:B11.

2. Create an XY scatter func-
tion graph by using the
ChartWizard on the Insert
menu. Save your work.

3. Note from the value of
coordinates (above) and from
this graph that the value of y
changes sign between x=-5
and x=-4.5 (represented by

STEP A

DESCRIPTION

STEP B

SOLVING POLYNOMIAL EQUATIONS
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cell B3), between x=0 and x=1
(cell B8), and between x=1
and x=2 (cell B9). That means
that the solutions to the cubic
equation must lie between
those values.

Seek Your Goal
S O F T WA R E : M i c rosoft  Exc e l

W H AT TO DO: Now comes the
part where the spreadsheet
really shines.

1. Select cells A3, A8, and A9,
click on Format menu, choose
Cells, and format as Numbers
to four decimal places; format
B3, B8, and B9 as Numbers to
two decimal places.

2. Click on B3. This is your
first Goal cell.

3. On the Tools menu, choose
Goal Seek. You should see B3
in the Set Cell box. 

4. Remember that the equa-
tion you are solving is 2x3 +
6x2 - 18x + 6= 0, so you'll want
to enter 0 in the To Value box.

5. The cell you want to
change to reach that value is
the variable you're solving for,
x. In the By Changing Cell box,
type A3.

6. Click OK on the Goal Seek
Status box, which should
return a value of 0.

7. The value in cell B3 should
also now read 0.00, while cell
A3 reads -4.9434. This is one
of your solutions for x.

8. Repeat this process for
cells B8 and B9 to reach the

other two valid values for x.

9. Save your work.

Now Try These!
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: Now that you

know how to set up your
spreadsheet to solve cubic
equations, try it out on the
equations below using the
specified domains (ranges of
numbers). Make up equations
with a friend and test them
out. Then see if you can find a
way to use spreadsheets to
solve other kinds of equa-
tions, such as quadratic.

SOLVING POLYNOMIAL EQUATIONS
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Equation                  Domain

x3 - 4x2 - 5x + 14 = 0 -3, 6

x3 - x2 - 10x + 10 = 0 -4, 5

x3 - 4x2 - 2x + 4 = 0 -2, 4

x3 - 3x2 - x + 1 = 0 -1, 4

x3 - 2x2 - 3x + 5 = 0 -3, 5

x3 - 7x2 - 11x + 3 = 0 -2, 6

3x3 - x2 - 40x + 48 = 0 -5, 4

x3 - 5x2 - 5x + 3 = 0 -2, 4

x3 - 4x2 - 3x + 2 = 0 -2, 5

x3 - 27x - 27 = 0 -3, 6

STEP C

STEP D



HIGH SCHOOL

C A M P A I G N
HOT BUTTONS 

This simulation activity asks
students to work as staff e r s
for a politician (played by
you). They are assigned to
design, administer, and ana-
lyze a simple poll on an
i m p o rtant community issue;
to develop a position state-
ment based on poll re s u l t s ;
and to persuasively pre s e n t
the candidate's stand on the
i s s u e .

◆ To sharpen understanding
of the role of public opinion
polling in the political process

◆ To develop data design, col-
lection, and analysis skills
using spreadsheet tools

◆ To provide practice with
persuasive writing and public
speaking

◆ Basic understanding of
M i c rosoft Excel

◆ Familiarity with Microsoft
Word

◆ Ability to create basic
slides using Microsoft
PowerPoint

Three to six class periods;
partners may supplement
with work sessions outside of
class

Introduce the topic by bring-
ing into class several press
reports about proposals by
the President, your state's
governor, or a local politician
on important public issues.
Ask students how they think
such proposals are developed,
and what role public opinion
plays. 

Introduce this simulation
activity by telling students
that you will be playing the
role of a local politician and
that they are your staff. Say
that you are very interested in

the problem of water pollu-
tion in your local area, and
that you think your communi-
ty needs a water purification
program. (If there is another
"hot button issue" actually
being discussed in your com-
munity right now, you might
want to substitute that for
water quality.) But without a
carefully developed campaign
to win public support, nothing
will happen on this issue. Tell
students that you need their
help in finding out how citi-
zens feel about water quality
and then in building a cam-
paign based on their concern s .

Divide your class into pairs,
and set deadlines for them to
present their work to you
after each step in the Student
Activity.

REQUIRED SOFTWARE
◆ MICROSOFT® EXCEL 97
◆ MICROSOFT® WORD 97
◆ MICROSOFT® POWERPOINT® 97

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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◆ Have students use Microsoft Publisher 97 to create pam-
phlets, posters, or ads based on their work in this activity.

◆ Have your students choose their own hot button issue to
address in a repeat of the activity.

◆ Ask students to analyze survey results that they read in the
news. How were the questions framed? Who was chosen to
answer? Why are certain highlights chosen? If possible, send
away for the actual survey report and take a closer look. 

E x t e n s i o n  A c t i v i t i e s



For better or worse, politics
has become entwined with
public opinion polling.
Politicians and their staffs
work hard to identify "hot but -
ton issues"– topics that voters
care passionately about – and
craft positions and programs
accordingly. For this activity,
imagine you and your partner
are key policy strategists for a
local politician (played by
your teacher). This politician
has a hunch that water quali-
ty is an issue of great concern
to citizens in your town, and
that they might support a pro-
posal to build small-scale
water-purification plants at
strategic locations. But similar
proposals have failed in the
past. It's up to you to make
the difference. 

Brainstorming
Poll Questions
S O F T WA R E : N o n e

W H AT TO DO: Your candidate
believes her water-purification
proposal would have three
important benefits: the pro-
tection of sources of drinking
water, the rehabilitation of
wildlife habitats, and the cre-
ation of a swimming and
recreation area on the out-
skirts of your town. Your poll
should help determine how
the public feels about these
three goals, and what prob-
lems they might foresee with
your boss's proposal.

The key is to design your
questions so they can be ana-
lyzed statistically. That means
asking questions that can be
answered Yes or No; providing
a scale for answers, such as 1
to 5, with 1 being Strongly
Agree and 5 being Strongly
Disagree; or providing multi-
ple choice answers. 

You'll also want to gather data
about the people who will
answer your poll, to help you
better analyze your results.
For example, you might want
to record their age and gen-
der, so you could later report
that "new recreation facilities
are especially important to
males ages 14-16."

With your partner, brainstorm
a list of at least three ques-
tions you’ll want to ask.

Designing Your
Poll Form
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: You will be cre-
ating a basic spreadsheet doc-
ument that you can print out
for conducting your poll and
then enter your collected data
into. Here's how:

1. Open Excel. In cell A1 of
the blank worksheet, enter a
title such as "Poll on Water
Quality" (see sample below).
Select cells A1:F1 and click
the Merge and Center button
on the Formatting toolbar.

2. Skip a row, then type in
your survey questions and
the answer scale (for example,
1 = not at all, 5 = extremely).

STEP A

DESCRIPTION STEP B

CAMPAIGN HOT BUTTONS

Student Activity
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Use printouts of a blank Excel worksheet to collect data in a poll of
your classmates and peers on your chosen hot topic.



You’ll be using a copy of this
worksheet as a script when
you survey, so make certain
your wording is clear.

3. Type in column headings
for the data you want to gath-
er from each participant (such
as Name, Age, M/F, and the
numerical answer for each
question).

4. Use Format to adjust the
row heights and column
widths to make it easier to
write in while you're polling.

5. Highlight the answer area,
go to the Format menu,
choose Cells, and click on the
Borders tab. Select inside and
outline borders to create a
neat grid (see page 28).

6. Save and print.

7. Now poll your classmates.
Pencil in the information
under each heading, including
the numerical answer to each
of your survey questions.

Analyzing Your
Data
S O F T WA R E : M i c rosoft Exc e l

W H AT TO DO: When your
polling is complete, follow
these steps:

1. Open your worksheet.

Enter and save your data.

2. To find the average answer
to your questions, select a
blank cell at the bottom of
each column and type = to
indicate a formula. Go to the
I n s e rt menu, choose Function,
and select Average. Highlight
the range of cells, for example,
= AVERAGE(D9:D18). Pre s s
E n t e r. Drag the fill corner to
F19 to copy this form u l a .

3. To find the percentage rep-
resented by each answer, first
find the total number of
answers by having Excel
count them. Select a cell
below any column of numbers
– for example, B19 – and type
the formula =COUNT(B9:B18).
On a separate area of your
worksheet, set up a table that
shows the frequency of each
answer from 1 to 5 for
Question 1, and have Excel
divide each frequency by your
total number of answers (such
as =4/B19). 

4. Create a graph of your per-
centages by selecting your

CAMPAIGN HOT BUTTONS 

STEP C
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percentage cells, choose
ChartWizard button on the
toolbar (see sample results at
top of previous page).

5. To experiment with other
ways of analyzing your data –
by respondents' gender and
age – use the Filter function
under Data. Highlight the label
cell on any column, go to the
Data menu, select Filter, and
choose AutoFilter. This cre-
ates a pulldown menu of all
the variables in your data
(such as M and F for gender).
When you select a filter, Excel
will show only the rows that
match. You can then average
these subsets, find their per-
centages, or create charts for
them using the same steps
you followed above.

Developing a
Briefing Paper
S O F T WA R E : M i c rosoft Wo rd ,
M i c rosoft Exc e l

W H AT TO DO: Your next task
is to brief your boss, the
politician, on the results of
your poll and how best to pre-
sent the water-purification
proposal to the public. Review
your data and decide which
two or three conclusions are
most important – and what
strategies you recommend as
a result. 

For example, if a large per-
centage of your respondents
are very concerned about
water quality, you'll want to
suggest emphasizing this
when talking to the public and

the press. If more males than
females seem to care about
protecting wildlife, the politi-
cian may want to create a spe-
cial "save the animals" pam-
phlet targeting males.

Write up your recommenda-
tions in a two-page briefing
paper; import spreadsheet
data and charts as needed.

Presenting Your
Campaign
S O F T WA R E : M i c ro s o f t
Powe r Po i n t

W H AT TO DO: Congratula-
tions! Your boss, the politi-
cian, was very impressed with
your poll and analysis. She
even agreed with all of your
recommendations! Now she
wants to take her water-purifi-
cation campaign public. She
has scheduled a press confer -
ence and asked  you to create
a presentation. You’ll need at
least one PowerPoint slide for

each recommendation. 

1. Launch PowerPoint, open a
new file, and choose Blank
Presentation. 

2. Go to the Format menu,
click on Apply Design, and see
if any of the styles there fit
your message. Or you could
look through clip art files from
Office 97 and Microsoft
Publisher for a water-related
graphic that you could import
into the Master slide as a
motif that appears on all of
the slides in your presentaton. 

3. To create eye-catching
graphic headlines, go to
Insert, choose Picture, and
click on WordArt. 

4. Bring in graphs from the
Excel worksheets you devel-
oped in Steps A-C. This cre-
ates a Hyperlink to take view-
ers back to the Excel files.

5. Use the Animation function
to create lively, attention-get-
ting sounds and transitions
from slide to slide. 

CAMPAIGN HOT BUTTONS
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STEP E

STEP D



MORE RESOURCES
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Now you can master Microsoft 
desktop applications using 

real-life classroom examples!

Word 97

PowerPoint 97

Excel 97

Front Page 98 

Publisher 98

AVAILABLE FREE TO K-12 EDUCATORS AT:
www.microsoft.com/education/k12/resource/lessons.htm

IN AND OUT 
OF THE 

CLASSROOM

NEED HELP?
Microsoft 

Office Assistant 
is just a click away!

In all of the Microsoft Office 97
applications (Word 97, Excel 97,
PowerPoint 97, Access 97, Outlook
97), a click on the Help Menu or Help icon calls
forth the world’s friendliest assistant. Type in your
question in plain English, and the Office Assistant
will search for the answer. The Office Assistant will
also invite you to scroll through Help Topics and



M i c ro s o f t® O ffice 97, P ro fessional Edition
An all new Office 97 integrates intelligent applications with the power of the Web. Easily
insert hyperlinks between Office documents or out to the Internet. Save your documents
as HTML and you have an instant Web page. Office 97, Professional Edition i n c l u d e s :
Microsoft Excel 97, Word 97, PowerPoint 97, Outlook 97, Access 97, a n d M i c r o s o f t
Bookshelf Basics for quick reference to the tools you need most. Standard Edition does
not include Access 97 or Bookshelf Basics.
Wi n d ows 95; earlier version available for Windows 3.1, MacOS
Estimated Academic Price: $199.00, Professional Edition; $159.00, Standard Edition
w w w. m i c ro s o f t . c o m / o ff i c e /

M i c ro s o f t® E n c a rta 98 Encycl o p e d i a , D e l u xe Edition
This newly updated version of Microsoft’s award-winning, interactive multimedia encyclo-
pedia for students and teachers turns any classroom into resource-rich research library.
Try a Virtual Tour of a fascinating destination, or explore important cross-curricular topics
through multimedia Collages. The D e l u x e edition features Research Organizer, a tool that
teaches students research skills and information literacy while helping them turn E n c a r t a
information into top-notch papers, reports, and presentations. 
Wi n d ows 95; earlier version available for Windows 3.1, MacOS
Estimated Academic Price: $69.95, Deluxe Edition
w w w. m i c ro s o f t . c o m / e n c a rt a /

M i c ro s o f t® E n c a rta Vi rtual Globe, 1998 Edition
The essential geographic reference companion to Microsoft’s Encarta 98 Encyclopedia,
Encarta Virtual Globe brings you the world as never before with the most realistic 3-D
maps, engaging multimedia, and authoritative content. For quick facts, schoolwork, or
armchair travel, Encarta Virtual Globe is newest way to visit and learn about places, peo-
ple, and cultures around the globe. 
Wi n d ows 95; earlier version available for Windows 3.1, MacOS
Estimated Retail Price: $54.95.
w w w. m i c ro s o f t . c o m / gl o b e /

M i c ro s o f t® I n t e rnet Explorer 4.0
The fast, easy, and safe way for teachers and students to discover the World Wide We b .
Includes Internet e-mail, makes quick work of graphic displays, provides easy access to
Favorite sites and popular search engines, and supports filtering and security systems for
student safety. 
Wi n d ows 95, Wi n d ows NT, Wi n d ows 3.1, and Apple Macintosh 6+
FREE to download
w w w. m i c ro s o f t . c o m / i e / d ow n l o a d

Microsoft® Publisher 97 Academic Edition
Create effective, high-impact publications and World Wide Web sites with Publisher 97. It’s
perfect for all you classroom and home projects. In just minutes, you and your students
can turn ideas into professional-looking publications, in print and online. Includes In and
Out of the Classroom with Publisher 97, a step-by-step teacher activity guide, inside acad-
emic product box.
Wi n d ows 95; earlier version available for Windows 3.1
Estimated Academic Price: $59.95.
w w w. m i c ro s o f t . c o m / p u bl i s h e r /

M i c ro s o f t® G reetings Wo rk s h o p
Create Hallmark-quality cards, invitations, calendars, banners and more. New projects
include oversized posters, vertical banners, stationery, and stickers. Choose from more
than 2000 Hallmark Connections, or add your own messages and photos.
Wi n d ows 95
Estimated Retail Price: $29.95, Standard; $49.95, Deluxe Edition
/ / G re e t i n g swo rk s h o p. m s n . c o m

098-71439

Estimated prices are subject to change without notice.
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